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1 FT90x Toolchain Introduction

The free FT90x toolchain is a port from the popular GNU toolchain which includes the following
components:

e GCC based compiler
e GNU Binary Utilities (binutils) based tools, most notably:
o as - the assembler
o Id - the linker
o and some other useful tools such as objdump, ar, ranlib, addr2line, etc.
e GDB based debugger
e In addition, a plugin for the Eclipse IDE is also provided. This plugin allows the FT90x
toolchain to integrate seamlessly into Eclipse and as a result, greatly simplifies the
development works for the FT90x MCUs.

1.1 Compiler: ft32-elf-gcc

The FT90x compiler is used similarly to standard GCC. It supports most GCC options such as -Wall,
-01, -02...

Example: To compile a C file into an object file:

ft32-elf-gcc -c -o file.o file.c

1.2 Assembler: ft32-elf-as

The FT90x assembler functions in the same way as the standard GNU assembler (GAS). The
assembly files should be written using the GAS general syntax.

Example: To compile an assembly file into an object file:

ft32-elf-as -o file.o file.s

1.3 Linker: ft32-elf-Id

Typically running behind ft32-elf-gcc, the FT90x linker performs two tasks. It first links all object
files and libraries into a.out and then convert’s a.out into an executable file for FT90x. Similar to
the FT90x compiler and assembler, the FT90x linker supports most standard GNU linker options.

Example:
e To link various object files / libraries into an .elf file:
ft32-elf-gcc -nostartfiles filel.o file2.0 -L <libfolder> -l lib1 -I lib2 -o file.elf
e To convert file.elf into a FT90x binary file, which can be programmed into the chips:

ft32-elf-ld --oformat binary -o file.bin file.elf
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1.4 Debugger: ft32-elf-gdb

The FTDI programmer/debugger module is needed for the communication between ft32-elf-gdb
and the chip. The communication follows the GDB remote protocol. In addition to the debugger
module, two software components are needed:

e GDB Bridge: for converting GDB commands into the debugger module commands
e Bootloader: for receiving & executing the debugger module commands

More information on how to use the FT90x debugger can be found in section 5.1.3 of this
document.

1.5 A useful utility: ft32-elf-objdump

ft32-elf-obj dump displays various information about object files. Its usage is the same as
standard GNU objdump.

Example: To disassemble file.elf into a text file

ft32-elf-objdump -d file.elf > disassembly.txt
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2 Setting up the FT90x Toolchain

2.1 Installing the toolchain

The toolchain can be installed by running the setup wizard “FT90x Toolchain Setup_version.exe”,
which can be downloaded from the FTDI website. Please follow the steps in the wizard to complete
the installation process. It is recommended to use the default settings for simplicity.

Note: all applications should be closed before the installation or a restart may be required.

[ & 190« Toolchain Setup = =)
W Chip
Welcome to the FT90x Toolchain Setup Wizard
BRIDGING )
TECHNOLOGIE

This wizard will guide you through the installation of the FT90x Toolchain.

Itis recommended that you dose all other applications before continuing. This will make
it possible to update relevant system files without having to reboot your computer.

Click Next to continue.

MNext > Cancel

Figure 1 Toolchain Setup Wizard Dialog box

In the License Agreement dialog box, click I Agree.

r % FT90x Toolchain Setup l = o S| )
Please review the license terms before installing the FT90x Toolchain. a i
& Chip
\ Press Page Down to see the rest of the agreement.
BRIDGING ' L FT90x Toolchain Licensing Information
TECHNOLOGIES

GNU Binutils is distributed under the GNU GPL License.
GNU Compiler Collection (GCC) is distributed under the GNU GPL

License.
GNU Debugger (GDB) is distributed under the GNU GPL License.

GNU Make and GNU Coreutils are distributed under the GNU GPL
License.

The Cvowin DT T < and lhraries are dictribitad inder the GNTT GPT

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install the FT90x Toolchain.

< Back I Agree Cancel

Figure 2 License Agreement Dialog box
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Go through the Revision and Release information and click Next.

Revision and Rel Ir
View information about the revisions of components induded in the FT90x Toolchain.

[m Press Page Down to see the rest of the Revision and Release Information.
\ Release Information

BRIDGING
TECHNOLOGIES This is Release 2.2.8 of the FT98x Toolchain for Windows,
comprising the command-line tools (GCC, GNU Binutils, GDB), the
Eclipse IDE and the drivers needed to start development. A set
of examples are included to demonstrate how to use the drivers.
Projects created with the FTDI Eclipse plugin are compiled using
a Makefile. Therefore, the latest version of some necessary
GnukWin32 utilities (make and coreutils) are also included.

Revision Information

Version: 2.2.8

This information can also be found in Release Motes, txt in your installation directory.

< Back | Mext = I Cancel |

Figure 3 Revision and Release Information Dialog box

Select the Components and click Next.

Choose Components

Choose which features of the FT90x Toolchain you want to install.

Check the components you want to install and uncheck the components you don't want to install.
\\ Click Next to continue.

BRIDGING
TECHNOLOGIES Select components to install: }22;%?32:@

component ko see jts
description,

MCCI USE Stack Tools
FT90x Driver Library 5
FT90x Example Applici

Update PATH variable
Create icons on desktt

Space required: 1023, 7MB

Figure 4 Components Dialog box
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Click Browse and select a different file path for FT90x Toolchain installation. Alternately, continue
installing in the specified folder by clicking Next.

F ™
% FT90x Toolchain Setup l = ﬂ
Choose Install Location ’-;-'- FTDI
Choose the folder in which to install the FT90x Toolchain. '.‘ Ch | p
Setup will install the FT90x Toolchain in the following folder. To install in a different folder, dick
\ Browse and select another folder, Click Mext to continue.
BRIDGING
TECHNOLOGIES

Usk DISPLAY

C:\Program Files (x85)\FTDI\FT90x Toolchain Browse...

Space required: 401.3MB
Space available: 36.7GB

b " "Desﬁnaﬁon Folder

".,. “

[ < Back || Next > | [ Cancel

Figure 5 FT90x Toolchain Install Location Dialog box

Click Browse and select a different file path for installing FT90x examples and documents.
Alternately, continue installing in the specified folder, by clicking Install.

4 FT90x Toclchain Setup El_ﬂﬂ
Choose Install Location 4 FTD'

Choose the folder in which to install the FT90x Toolchain. Ch | p

=]

\ Please select the installation folder for the FT90x examples and documents.

BRIDGING ' |
TECHNOLOGIES

Usk DISPLAY

C:\UsersY. subramanian\Documents \FTDIFTS0x Browse...

Space required: 401.3MB

Space available: 36, 7GE

b " "FFQUX Examples and Documents Installation Folder

’@..‘*

| <pack || msal | [ cancel
L

Figure 6 FT90x Toolchain-Examples & Documents Install Location Dialog box
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The FT90x Toolchain installation progress bar is displayed.

% FT90x Toolchain Setup

Installing

>\

BRIDGING

Please wait while the FT90x Toolchain iz being installed.

Extract: com.joraft.jsch_0.1.51.v201410302000.jar

Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Extract:

TECHNOLOGIES

Extract:

compositeContent2 128826640, jar
content-1303763772.jar..
content-1585421349.jar...
content-1893076428. jar...

content-306658927.jar
content1051727163.jar

content1330234655.jar...
content1591895555.ar...
content1593412569.jar...
content2039793951.jar...

. 100%

100%
100%

100%
100%
100%
100%:

Extract:

content89816961.jar... 100%

Cutput folder: C:\Program Files (x86) \FTOIVFT90x ToolchainToolchainedipse'p2'org.edi...
Qutput folder: C:\Program Files {x88) \FTDI\FT90x ToolchainToolchainedipse'plugins

Extract:
Extract:
Extract:
Extract:
Extract:
Extract:

com, ftdichip, ft90x.build .gce_0.0. 1, 201505270745.jar. .. 100%
com. ftdichip. ft90x.build.gce_0.0. 1. 201505270753, jar. .. 100%:
com.google.guava_15.0.0.v201403281430. jar... 100%
com.ibm.icu_52.1.1.v201501240615.jar... 100%:
com.joraft.jsch_0.1.50,v201403120620.jar... 100%
com.jeraft.jech_0. 1,51, v201410302000.jar

Cancel

e ] e ]

Figure 7 FT90x Toolchain - Installation Progress Window

If Java is selected for installation, the following window is displayed.

’
Java Setup - Welcome

Welcome to Java

Java provides access to a world of amazing content. From business
solutions to helpful utilities and entertainment, Java makes your Internet
experience come to life.

Mote: Mo personal information is gathered as part of our install process.
Click here far more information on what we do collect.

Click Install to accept the license agreement and install Java now.

Install = ]

[ Cancel

|

[] change destination folder

Figure 8 Java Setup Window
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Click Install and follow the instructions to install Java on the machine.

-
Java Setup - Welcome

Status: Installing Java

3 Billion

Devices Run Java

= ]a'\.'a" #1 Development Platform m

Figure 9 Java Setup Progress Window

During installation, if a Python 2.7.10 Setup dialog box is displayed, select the appropriate
option as required and click Next.

rﬁl Python 2.7.10 Setup =)

Select whether to install Python 2.7.10
for all users of this computer.

(7 Install just for me (not available on Windows Vista)

python

for

windows

Figure 10 Python Setup Dialog box
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Select a different Destination Directory to setup Python. Alternately, continue installing in the
specified folder by clicking Next.

rjgl Python 2.7.10 Setup =)

Select Destination Directory

Please select a directary for the Python 2.7.10 files.

&% Python27 -

python

for

windows

|C:\Python27",

| | cancel |

e

Figure 11 Destination Directory Selection Dialog box for Python Setup

Select the Python features to be installed or continue with the default features and click Next.

[ ) Python 2.7.10 Setup =)

Customize Python 2.7.10

Select the way you want features to be installed.
Click on the icons in the tree below to change the
way features wil be installed.

Register Extensions
Tl Tk
Docurmentation
Utility Scripts

pip

Test suite

Add mudbboe maen do FPodb

m

Python Interpreter and Libraries

python

for This feature requires 25MB on your hard drive. It
g has 6 of 7 subfeatures selected. The subfeatures
WIﬂdOWS require 30MB on your hard drive.
[ Disk Usage ] [ Advanced ] [ < Back ][ Mext = ] [ Cancel ]

Figure 12 Python Features Customization Dialog box
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Python installation progress bar is displayed.

[ 381 python 27.10 Setup =)

Install Python 2.7.10

Please wait while the Installer installs Python 2.7.10. This may take
several minutes.

Status: Copying new files

Figure 13 Python Installation Progress Dialog box

Click Finish to complete the Python installation.

[ 18 python 27.10 Setup ) |

Complete the Python 2.7.10 Installer

Special Windows thanks to:
Mark Hammond, without whose years of freely
shared Windows expertise, Python for Windows
would stil be Python for DOS.

python

ﬂﬁ
windows

Click the Finish button to exit the Installer.

Figure 14 Python Installation Completion Dialog box
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The FT90x Toolchain installation is continued.

% FT90x Toolchain Setup

Installing
Flease wait while the FT90x Toolchain is being installed.

[r\\\ Extract: com.jeraft.jsch_0.1.51.v201410302000.jar

BRIDGING
TECHNOLOGIES Extract: compositeContent2128826640.jar ~

Exftract: content-1303753772.jar... 100%

Exfract: content-1585421349 jar... 100%

Extract: content-1398075428.jar... 100%

Exftract: content-306658927.jar

Exftract: content1051727163.jar

Exftract: content1330234655.jar... 100%

Exftract: content1591895555.jar... 100%

Extract: content1593412569.3ar... 100%

Exftract: content2039793951.jar... 100%

Exftract: content99816961.jar... 100%

Output folder: C:\Program Files (x86) \FTDIVFT90x Toolchain{Toolchain\edipse\p2iorg.edi...
Output folder: C:\Program Files (x86)WFTDIFT90x Toolchain{Toolchain\edipseplugins
Extract: com. ftdichip. ft90x.build.gcc_0.0. 1. 201505270745, jar... 100%

Extract: com. fidichip. ft90x.build.gcc_0.0. 1. 201505270753, jar... 100%:

Extract: com.google.guava_15.0.0.v201403281430.jar... 100%

Extract: com.ibm.icu_52.1.1.v+201501240615.jar... 100%:

Extract: com.jeraft.jsch_0.1.50.v201403120620.jar... 100%:

Extract: com.joraft.jsch_0.1.51.v201410302000.jar =

[ < Back H Mext = I [ Cancel

Figure 15 FT90x Toolchain - Installation Progress Window

Select the Open AN_325 checkbox to start immediately after closing the Setup Wizard. Else leave
it unchecked. Click Finish to complete the FT90x Toolchain Setup.

#% FT90x Toolchain Setup

- ';l

@ FTDI
@ Chip

m' Completing the FT90x Toolchain Setup Wizard

BRIDGING
TECHNOLOQOGIES

The FT90x Toolchain Setup Wizard has completed successfully. Click Finish to exit the
Setup Wizard. A quick start guide for using the toolchain iz induded in the application
notes AM_325. For more information, as well as the latest updates, please visit FTDI's
website at www. ftdichip.com.

¥ Dpen AN_325

[ Finish [ Cancel

Figure 16 FT90x Toolchain Setup Completion Dialog box
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After the installation, the toolchain can be found in the installation directory. The default location is
“C:\Program Files\FTDI\FT90X Toolchain” for 32-bit Windows and “C:\Program Files
(x86)\FTDI\FT90X Toolchain” for 64-bit Windows. This directory also contains the external utilities
needed. The FT90x drivers, sample applications and documents (if selected for installation) can be
found in "My Documents\FTDI\FT90x".

2.1.1 Installing Java Runtime Environment Manually

The toolchain requires the Windows MSI Installer (msiexec.exe) while installing Java Runtime
Environment (JRE). The MSI installer can only process one installation at a time. Under some
conditions, msiexec.exe may have already been started by another Windows process during
automatic Windows Update for example. If the installer detects another instance of msiexec.exe
running in the background, the user will be prompted to either wait for the background MSI
Installer to complete and retry after 5 seconds or to skip the JRE installation entirely. This is
shown in Figure 17

-

4 FT90x Toolchain Setup =

staling @D

Please wait while the FT90x Toolchain is being installed.

Skipped: jre-8u101-windows-i586.exe

BRIDGINC 4 FT90x Toolchain Set_

I.-"'_"\-.I Setup has detected another instance of Windows MSI Installer
W' (msiexec.exe) running. Setup requires the Windows M3 Installer to
install the Java Runtime Environment (JRE) but it is unable to proceed

because msiexec.exe is already used by ancther process,

Click Yes to wait 5 seconds to retry JRE installation or Mo to skip. JRE
may also be installed separately from the following URL
http:/fwww.oracle.com/technetwork/java/javase/downloads/jre8-dow
nloads-2133155.htrml

Please install the 32-bit version (jre-cco-windows- 586, exe)

< Back | | Mext = Cancel

Figure 17: MSI Installer is busy

If the user skips JRE installation, JRE can be installed manually from the Oracle Website
(http://www.oracle.com/technetwork/java/javase/downloads/jre8-downloads-2133155.html) or by
re-running the FT90x Toolchain Installer later. Please ensure to install the 32-bit version of JRE
(jre-xxx-windows-i586.exe) as the Eclipse installed as part of the FT90x Toolchain install is 32-bit.
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2.2 Verifying the installation

1. Open a Command Prompt window by typing "cmd” in *Windows Start button > Search box”.
2. Type “ft32-elf-gcc --version” in the command prompt. It should give the following message:

ft32-elf-gcc (GCC) 7.0.0 20160708 (experimental)

Copyright (C) 2016 Free Software Foundation, Inc.

This is free software; see the source for copying conditions. There is NO

warranty; not even for MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.

If this message appears, then the toolchain has been successfully setup.
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3 Quick Start Guide: From creating to getting your
application to run on the FT90x MCUs

This chapter guides you through the steps to create a new application, compile and program it into
the chip. To debug your application, please refer to chapter 4 - “Setting up Eclipse for Debugging”.
For more information about the tools, as well as the advanced features, refer to chapter 5 -
“Advanced Topics”.

3.1 Creating a new project
Double click on the icon “Eclipse for FT90x” to launch the Eclipse IDE.

el s
Il

Figure 18 Eclipse for FT90x Icon

When you run Eclipse for the first time, it will ask you for the location of the workspace. Eclipse
will create some files within this directory to manage the projects. Specify a folder of your choice
and click OK.

= Workspace Launcher @

Select a workspace

Eclipse stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session,

Workspace: | - Browse...

Use this as the default and do not ask again

OK Cancel

Figure 19 Eclipse Workspace Selection

Note: The following message will be displayed if an existing workspace, which was created by an
older version of Eclipse, is specified. As there may be some configurational changes in files related
to workspace in the newer version of Eclipse which may cause issues, it is recommended to create
a new workspace and imported the existing projects there.
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i B
& Clder Workspace Version ﬁ

Workspace 'Ci/workspace’ was written with an older version of the product and will
be updated. Updating the workspace can make it incompatible with older versions of
the product.

Are you sure you want to continue with this workspace?

[] Do not warn again about workspace versions

Ok l [ Cancel

—

Figure 20 Eclipse Workspace Update

To create a new C project in Eclipse, on the menu bar click “File > New > C Project”. The C
Project wizard will open.

Give a name to the project, for example “Hello World”. By default, the new project will be created
inside the workspace you have chosen. If you want to change it, uncheck the box “Use default
location” and specify another location. Choose “Empty Project” for the project type and
“FTDIchip FT90x GCC"” for the toolchain. This ensures all the relevant FT90x include files are
part of the project. Click Next.

C Project

Project name must be specified

Project name:

Use default location
Chworkspace

default

Project type: Toolchains:

» = GNU Autotools Cross GCC
4 = Executable FTDIchip FT90x GCC

@& Empty Project Microsoft Visual C++
@ Hello World ANSI C Project

» [ Shared Library

> = Static Library

» (2= Others

> = Makefile project

Show project types and toolchains only if they are supported on the platform

Cancel

Figure 21 C Project Wizard
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In the next window, select both Debug and Release for the configuration and click Next.

Project type: Executable
Teoolchains: FTDIchip FT90x GCC

Configurations:

/| ) Debug
7| B3 Release

Figure 22 Project Wizard - Build Configurations Selection

The last window is for the toolchain prefix and location. By default, the values will be prefilled as
follows.

FT90x compiler prefoe  ft32-elf-

FT90x compiler path: | C\Program Files (x86)\FTOIVFT90x Toclchain\tools\bin | | Browse...
Figure 23 C Project Wizard - Toolchain Details

Click Finish to complete the New Project Wizard. A new FT90x project will be created in Eclipse.

3.2 Building the project

After the wizard completes, some folders and an empty source file (main.c) will be created.

4 =5 Hello World
- :,-:;j—f' Binaries
- [t Includes

- = Debug
= Includes
= Scripts

4 [= Sources
- |e] main.c

Figure 24 New empty project structure
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Let’s give main.c some content, for example:

#tinclude <stdio.h>
#tinclude <ft900.h>

int main(void)
{
/* Enable UARTO */
sys_enable(sys _device_uart9);
/* Make GPIO48 function as UARTO_TXD and GPIO49 as UARTO_RXD */
gpio_function(48, pad uarto_txd);
gpio_function(49, pad uarté _rxd);
/* Open UARTO */
uart_open(UARTO,
1,
UART_DIVIDER_115200_BAUD,
uart_data bits 8,
uart_parity _none,
uart_stop _bits_1);
/* Print out a welcome message */
uart_puts(UARTO, "Hello World!\r\n");
/* Now keep looping */
while (1);

return 0O;

}

Save the file. Now the project can be built by clicking on the menu Project - Build Project, but

4

note that there are a few options like right-click on the project > Build Project and the icon.

Project | Run  Target Window Help
Open Project |

Close Project

| |4 Build &ll Ctrl+B
Build Configurations 4
1 Build Project

Figure 25 Building the Project

The console window at the bottom of the IDE shows the build status. If the build completes
successfully, two files will be created - “Hello World.elf” and “Hello World.bin”. The file to be
programmed into the chip is “Hello World.bin”. The .elf file is used for the debugger, as detailed in
the next chapter.
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{#! Problems J=| Tasks | & Conscle 32 [ Properties = B

S oG BB B
CDT Build Console [Hello World]

L o T e 7 e T T ey

ft32-elf-gcc -I"C:/Program Files/FTDI/FT99x Toolchain/Toolchain/hardware/include” -I".., "
'Finished building: ../Sources/main.c’

'Building target: Helle World.elf'

'Invoking: FT9@x GCC Linker'

ft32-elf-gcc -nostartfiles -L"C:/Program Files/FTDI/FT9@x Toolchain/Tooclchain/hardware/:
'Finished building target: Hello World.elf'

'Invoking: FT9@x Flash File Generator'
ft32-elf-objcopy --output-target binary "Hello World.elf™ "Hello World.bin™
'Finished building: Hello World.bin' -

4 11 b

Figure 26 Build Status

| .settings File Folder | Sources File Folder

| Debug File Folder |_|Hello World.bin ~ EINM File 51 KB

JIncludes File Folder | Hello Warld.elf ELF File 355 KB

| Scripts File Folder || makefile File 2 KB

| Sources File Folder 5.] objects.mk Makefile 1 KB
|| .cproject CPROJECT File 16 KB ;T.I sources.mk Makefile 1 KB
|| .project PROJECT File 1KE

Figure 27 List of Files after building

3.3 Programming the binary file into the chip

The FT90x Programmer is provided together with the toolchain. There are a couple of options
available.

3.3.1 GUI Version

To run it, double click on the icon "FT900 Programming Utility” created on your desktop, if selected
during install, otherwise it can be found in:

C:\Program Files (x86)\FTDI\FT90x Toolchain\Toolchain\programmer\dist

®
gl S

(PAsis b= Lo LaadLa)
o) Wl iy

Figure 28 FT900 Programming Utility Icon
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You can also open the programming utility from Eclipse by selecting it in the FTDI Utilities menu or
the toolbar icon as highlighted in Figure 29:

: Search Project Run | FTDI Utilities | Window  Help
@ & (cf~ A9~ ¢ @ FT900Pregramming Utility  Ctrl+Alt+U
@ FT900 GDE Bridge Ctrl+Alt+EB

Figure 29 FTDI Utilities Menu

After the splash message the following screen will appear.

% FT%x Pregramming Utility l = | |_ﬂh
@ Program via One-Wire interface \\
BRIDGING
TECHMNOLOGIES

) Program via USB (DFU) interface
) Add/Customize DFU-suffix (DFU binary)

~) Customize Bootloader file

Mext

Figure 30: FT90x Programmer - Work with One-Wire

Select the “"Work with One-Wire” option and click Next. The next screen shows a list of supported
devices that you might wish to program.

When a valid FT900 and Programmer module are detected, the information will be displayed in the
list. Select the device you wish to program and click Next to launch the programmer window.
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[ % FTo: Programming Uty I lacon =) |
Interface m

. BRIDGING
One-Wire TECHMOLOGIE
Device Programmer Programmer Serial ...
FT300 UMFTPD2A A FTKIRIESA

Figure 31: FT90x Programmer - Device Selection

In the programmer window, leave everything as default. Specify the location of the binary file and
click Start. If the Verify check box is selected, an icon will show up next to the status bar to
indicate whether the flash memory has been properly programmer.

,
T L T

| |{Flash &PV} D2y | Data Log | About|
Device m
FTa00 BRIDGING |~
TECHNOLOGIES
Interface Target
One-Wire @) Flash ) PM
Config Address {hex)

[ verify [ Exdude bootloader [ Keep existing bootioader
Progress |

Custom (@ Factory Start ] [ Cancel ]

Figure 32 FT90x Programmer - Flash and PM Screen

More information on the utility can be found in the ‘About’ tab, then click on Help.
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3.3.2 Command Line Version

FT900Prog.exe is available to run at a command prompt. Enter FT900Prog.exe to see the options
available. See section 5.1.2 for more details.

This can also be run within Eclipse as an External Tool. See Figure 33 for settings found in Run »>
External Tools - External Tools Configurations.

2 External Tool: Configurations 5]
Create, manage, and run configurations #
X L Mame: FT90 Prosgram MTP
T Man Relieth | o Eudd B8 Ervareermnent | | Common
a O Pregiam Location:

G, FT30x Progeasn MTR
C\Program Files [BENFTONFTI0: Toolchaw Toolchain' programmen, daf FIS00Prog.ece

Breswse Workspace., | Browse File Sntem Warables...

Warlong Diectons

Browese Workipace... | Brovese File Syttem... | | Varuablet..

Arguements:

-F "Hpregect_loc i oonfig name i projesct_namae| I ipeoject_namelbin® 0w

‘Warsbes...

Hote: Enclose an angrament containing spaces using doulle-quaotes [

Filter mnatchid 2 of I demd

7 Rur | Clede
Figure 33 FT90x Programmer in Eclipse

3.4 “Hello World” in action, and more...

The “Hello World” example above will send a message to a serial terminal via the FT90x UARTO
port. Open a terminal on your computer, for example Tera Term or HyperTerminal. Apply the
following settings:

e Baud Rate: 115200
e Parity Bit: None

e Data Bit: 8

e Stop Bit: 1

e Flow Control: None

Now when you reset the MCU, the message will be printed to the terminal.
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& FT90x - HyperTerminal = | )t S
File Edit View Call Transfer Help
Dw 3 D&

>Hello World!

q T D

Connected 0:00:31 Aute detect 115200 8-N-1 NUM

Figure 34 Hello World

Congratulations! You have just completed your first project for FT90x. The FT90x toolchain comes
with plenty of examples, which demonstrate a variety of features. If you have selected to install
them in the Toolchain Installation Wizard, by default they can be found in:

"My Documents\FTDI\FT90x\version\Examples”

The Eclipse project has already been setup for these examples, as suggested by the presence of
two files - “.cproject” and “.project”. Instead of creating a new project, you can simply import
these projects into the workspace. To do this:

W=

On the Menu bar, choose “File > Import”

In the Import window, choose “General > Existing Projects into Workspace” and click “"Next”.
In the next window, set the root directory to "My Documents\FTDI\FT90x\version\Examples”.
The projects will be detected by Eclipse.

Select which projects you wish to import and click Finish to complete the importing process.
This is an example of how Eclipse would look like with the sample applications. Please refer to
AN 360 (which is also included with the toolchain installation) for more details about these
applications.
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£ C/C++ - GIO Example 1/gpio_examplel.c - Eclipse

= =
File Edit Source Refactor MNavigate Search Project Rum FIDIUtiities Window Help
N |- Rv ' N % @G- (-G B0~ wmo g = PG O Quick Access
[ Project Explorer 1% k-4 ¥ = O  [g gpio_eamplelc 3 = B8 I Outline
» (25 ADC Example 1 49 #include <ft988.h> -
» 5 ADC Bxample 2 50 x
G5 cam.coample 1 51 #define STR(a) STR_(a) o swinth
> eample.] 52 #define STR (a) #a o 900k
> % CAN Bxample1 5 - # STRO
» {5 CAN Example 2 4 #define GPIO_PIN 18 # STRO
CAN Eample 3 # GPIOPIN
» 5 DAC Example 1 "D{: ;E"‘P“’“;“J' £+ setuplvoid) : void
void loop(void);
» 55 DAC Example 2 p(void) £+ loop(usid): void
> i DAC Example 3 int main(void) @ main(void)  int
» 5 eth_example_1 { ® setup(): void
4 (5 GPIO Bxample1 setup(); ® loop(: void
» 4 Binaries for(;;) loop();
, &) Includes N return 2
» & Debug

> €] gpio_examplel.c
» (5 GPIO Example 2
» 5 GPIO Example 3
12C Master Example 1
> (25 12C Slave Eample 1
125 Example 1
» 5 125 Example 2
» 5 PWM EBxample 1
> 5 PWM EBxample 2
5 PWM Eample 3
> (25 RTC Bampled
> (5 RTC Example 2
» 25 SD Host Example 1
> (5 SPIMaster Example 1
(5 SPIMaster Example 2
> (5 SPIMaster Bxample 3
» 5 SPISlave Example 1
» 5 Timer Example1
> C5 Timer Bxample2
» 5 Timer Bxample 3
> 5 uart_example 1
» 5 vart_example 2
> 5 vart_example 3
» (5 Watchdog Example 1

(=5 GPIO Example 1

void setup()
{

Enable the UART Device...

sys_enable(sys_device uart0);
iake GPIO4E function as UARTE_TXD and GPIO49 function as UARTE_RXD

gpio_function(48, pad_uartd txd); /* UARTG TXD

gpio_function(49, pad _uartd rxd); /* UART® RXD */

uart_open(UARTE, /

UART_DIVIDER_19200_BAUD,
uart_data_bits_§,
uart_parity_none,
uart_stop_bits 1);

I

79

/= Print out a welcome message.
uart_puts (UARTE,

2 \x18[23" /* ANSI/VT160 - Clear the Screen
3 "\x1B[H" /* ANSI/VT188 - Move Cursor to Home */

"(C) Copyright 2014-2615, Future Technology Devices Intermational Ltd. \rin”
85 . \rin”
86 "Welcome to GPI0 Example 1... \rin"
- Pgitet

"Toggle a pin on and off.\r\n"

. \r\n”

the pin
GPIO_PIN, pad dir_output);

& Console 52
CDT Build Consele [GPIO Example 1]

ft32-elf-gee -L"C:/Program Files (x86)/FTDI/FTOBx Teolchain/Toolchain/hardware/1ib™ -Wl,--gc-sections
*Finished building target: GPIO Example 1.e1f’

*Invoking: FT98x Flash File Generator’
ft32-€1f-1d --oformat binary "GPIO Example 1.elf"
*Finished building: GPIO Example 1.bin’

© "GPIO Example 1.bin"

*Invoking: FT9@x Display Image Size'

ft32-elf-size --format=berkeley -x "GPI0 Example 1.elf"
text data bss dec hex filename

@x13%0 ©x206  Ox1 5527 1597 GPIO Example 1.elf

"Finished building: SIZE'

14:22:36 Build Finished (took 1s.434ms)

Figure 35 FT90x Examples

-W1,--entry-_start -o "GPIO Example 1.elf"

B~ =0

/gpio_examplel.c
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4 Setting up Eclipse for Debugging

Eclipse comes with an intuitive GUI for debugging applications. To enable this feature, eclipse
requires additional information about our debugger. The steps are presented below.

4.1 Build the application using the Debug configuration

The application should be built using the Debug configuration so that the debug information is
available. It is the default build configuration but can be verified in the Project menu.

Project | Run  Window Help

Open Project r'ﬁ ~ % - = |1
Close Project less a4 | [ Resource {S‘« Debug

o Build Al Ctrl+B f = 5

Build Cenfigurations [ Set Active b | v 1Debug
Build Project Manage... 2 Release

Figure 36 Build Configuration

4.2 Create a new debug configuration

A debug configuration is used by Eclipse to launch the debug GUI and only needs to be created
once for the FT90x Debugger. To create it:

On the Menu bar, select Run > Debug Configurations...

In the Debug Configurations window, double click on *C/C++ Remote Application”

Press the ‘New’ button to create a new debug configuration

In the next window, a Debugging Launcher will need to be specified. Click on “Select others...”
at the bottom of the window.

el NS

Using GDE (D5F) Automatic Remote Debugging Launche Apply Revert
Debug Close

Figure 37 Choosing a Debugging Launcher (1)

5. In the “Select Preferred Launcher” window, check “Use configuration specific settings”. Then
choose "GDB (DSF) Manual Remote Debugging Launcher”. Click OK.
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= Select Preferred Launcher l S

This dialog allows you to specify which launcher to use when multiple
launchers are available for a configuration and launch mode.

Use configuration specific settings I Change Workspace Settings...

Launchers:

GDB (DSF) Automatic Remote Debugging Launcher

Standard Remote Create Process Launcher

GDEB (DSF) Manual Remote Debugging Launcher |
—

@ T

Figure 38 Choosing a Debugging Launcher (2)

6. Now provide the details for the configuration. Specify the name of the Debug configuration,
for example “"FT90x Remote Debug”. Use this configuration to debug FT90x projects from now

on.

7. Under Main tab, specify the project and the .elf file for Application. The “Browse...” button
next to the project field will list all active projects. The .elf file can be found easily after the
project has been selected, by clicking on “Search Project...” button.

Mame: FT90x Remote Debug

2 Main :%?Debugger E Source | [£] Common

Project:
C/C++ Application: I

Debug/Helle World.elf

’ Variables... HSearchProject...H Browse... ]

Figure 39 Eclipse Debugging Application Settings

8. Under the Debugger tab, the user needs to provide some Debugger Options. Specify the path
to ft32-elf-gdb.exe (or simply “ft32-elf-gdb.exe”) in the Main sub-tab and make sure the
“"GDB command file” field is empty. ft32-elf-gdb.exe can be located in the toolchain
installation folder, under “tools\bin”.

MName: FT90x Remote Debug
£ Main ﬁ?Debugger E Source| (] Common

Stop on startup att main

Debugger Options

Main | Shared Libraries I Connectionl

GDB debugger.  C:\Program Files (x86)\FTDI\FT90x Toolchain\tools\ bin\f32-elf-
GDEB cormmand file: | Browse...

Figure 40 Eclipse GDB Settings
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9. Under the Connection sub-tab, choose the connection type to be TCP. Enter “localhost” for
the host name and 9998 for the port number.

Name: FT90x Remote Debug
= Main ﬁﬁ*Dehugger . Source| ] Commen
/| 5top on startup at: main

Debugger Options

| Main | Shared Libraries| Connection

Type: |TCP =

Host name or IP address:  localhost

Port number: 9998

Figure 41 Eclipse TCP Port Settings

10. Click “"Apply” and close the window.

A debug configuration for FT90x has now been created. To use the same configuration for other
projects, simply open it and select the right project and application, as presented in step 6 above.

4.3 Running the GDB Bridge

The GDB Bridge is needed for ft32-elf-gdb to talk to the MCU. To run it, simply double click on the
desktop icon “"GDB Bridge”.

oy
BRIDE

HMNG
Elrll'll.l'l:'..:.‘u

GUEEAHOE

Figure 42 GDB Bridge Icon

You can also launch the GDB Bridge from Eclipse by selecting it in the FTDI Utilities menu or the
toolbar icon as highlighted in Figure 43 FTDI Utilities Menu

: Search Project Run | FTDI Utilities | Window Help
@ & (]~ 50 v ¢ @ FT900 Programming Utility  Ctrl+Al+U
& FT900 GDE Bridge Ctrl+Alt+B

Figure 43 FTDI Utilities Menu
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The following window should appear:
c:\ |~|:;E] ﬁ-l‘

C:\Program Files (x86>\FTDI\FT98x Toolchain\Toolchain\utilities>D2XX library loa
ded OK

Figure 44 GDB Bridge in action

Now the tools are ready to debug the application in Eclipse.

Note: the user must close this debug GDB script when debugging is finished, otherwise it may not
be possible to program the device for example.

4.4 Debugging the application in Eclipse

1. Open the debug configuration that was created (FT90x Remote Debug) and click Debug. Note
that this will appear in the Debug button on the toolbar after running once.

Mame: FT90x Remote Debug
=l Main ﬁDebugger . Source| [£] Common
Project:
Hello World Browse...

C/C++ Application:
Debug/Hello World.elf

Variables... | |Search Project...| | Browse... |
Build (if required) before launching
Build configuration: |UseActi\re v|
Enable auto build Disable auto build
@ Use workspace settings Configure Workspace Settings...
Using GDB (D5F) Manual Remote Debugging Launcher - Select other...
|. Debug | | Close

Figure 45 Eclipse Run Remote Debugging
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The Debug perspective will be opened. The execution will stop at the first line in main(), as
shown below. Various debug commands (step into/over, resume, halt, stop, etc.) can now be
accessed from the toolbar via buttons. Function variables, setting breakpoints and viewing

physical memory in the memory tab, along with some other debug features are also available
now.

& Debug - Hello World/main.c - Eclipse Platform

File Edit Source Refactor Mavigate Search Project Run Window Help
Tl SRR E R i H-Q-Q-i®m®m v -]
% 4 ﬁ g = 57 Quick Access 521 | I Resource @CJ’CH—

45 Debug 52 [i% ¥ = B = Variables 52 =
4 [C] FT90x Remote Debug [C/C++ Remote Application] = ‘ ‘ et ¥ | =
|
4 (2 Hello World.elf
H= ) X MName Type Value
4 Thread #1 (Suspended : Breakpoint)
= main() at main.c:12 0x2f8
pil C:/Program Files (x86)/FTDI/FT90x Toolchain/tools/bin/ft32- o »

4 m 2 4 3

[g mainc 5 [ main.c = 0

® * main.c

EE Qutline &3 = 3
- Sl R e ¥ T
#include <stdic.h> = stdic.h

@ main{void) : int
int main(void)

1

m

printf{"Hello World!\n");
WRilE (1);
return @;

b

& Console &2 = |Exﬁ| ,E||="E'|=J‘='E|
FT90x Remote Debug [C/C++ Remote Application] C:/Program Files (x86)/FTDI/FT90x Toolchain/tools/bin/ft32-elf-gdb.exe (7.9.50.20150310)
Find the GDE manual and other documentation resources online at:
<http://www.gnu.org/software/gdb/documentations/>.

For help, type "help™.

Tvbe "apropos word" to search for commands related to "word". S
4

Writable Smart Insert 12:1

Figure 46 Eclipse Debug Environment

Note: If there is an error message about missing source file as below, locate the source file that
contains the main() function using the “Locate file...” button.

Locate the file or edit the source lookup path to include its location.

View Disassembly...‘

Locate File...

Edit Source Lookup Path... ‘

Figure 47 Eclipse Missing Source File

4.4.1 Watch variables in Eclipse debug perspective

If the watch variables fail to update or display incorrect values, check that the following flags exist
for the debug build (they are present by default in all projects created with FTDI eclipse plugin)

-fvar-tracking -fvar tracking-assignments
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Configuration: [DEbUQ [ Active ] '] [Manage Configurations...

&3 Tool Settings

# Build Steps ] Build Artifact l Eu_é Binary Parsers I €9 Error Parsers

(%3 FT90x Toolchain Settings Debug Level [Default (-g) v
4 53 FT90x GCC Compiler i - : -
(2 Dialect (icher debugging flags = -fvar-tracking -fvar-tracking-assignments
% Preprocessor ["| Generate prof information (-p)
(% Symbols || Generate gprof information (-pg)
6}» Includes [ Generate gcov information (-ftest-coverage -fprofile-arcs)

(33 Optimization

(%3 Debugging

(% Warnings

(%3 Miscellaneous
4 53 FT90x GCC Linker

(%3 General

Li’:’z Libraries

(%3 Miscellaneous

(22 Shared Library Settings
4 i) FT90x GCC Assembler

(%2 General
4 i3 FT90x Flash File Generator

Figure 48 Debug flags

4.4.2 Og compiler option when debugging

When compiling a project with no optimization (or -0O0) some useful debugging information may
not be generated at all, leading to possible unexpected results while debugging. To avoid this, it is
recommended to turn on -Og option when no other optimization flags are used. The FTDI eclipse
plugin does this automatically.

Note that if multiple optimization options are used, only the last option will be effective.

Configuration: [Debug [ Active | -

& Tool Settings |,ﬁ' Build Stepsl Build Artifactl Binary Parsersl 3 Error Parsers

@ FT90x Toolchain Settings Optimization Level [None (-0 v]

a 13 FT90x GCC Compiler
@ Dialect

(# Preprocessor |

Other optimization flags  -Og

Figure 49 Og compiler optimization option

More information can be found in the GCC documentation -
https://gcc.gnu.org/onlinedocs/gcc/Debugging-Options.html and
https://gcc.gnu.org/onlinedocs/gcc/Optimize-Options.html
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4.5 Eclipse features supported by ft32-elf-gdb

At the moment, not all features of the Eclipse debug perspective are supported by ft32-elf-gdb.
The current list of supported features is:

Breakpoint creation.

Single stepping/stepping in/stepping out of functions
Watch variables

Assembly instruction stepping
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s FTDI Projects

Besides the empty project used as the example in Chapter 3, there are several project types
specific to FTDI. They can be found under “Others” in the project type selection window. Currently,
there are two project types:

e D2XX Project
e Data Log (DLOG) Project

For more details about these project types, refer to "AN_360 FT900 Example Applications”, which
is included in the toolchain installation.

Project type: Teolchains:

- = GMU Autotools FTDIchip FT90x GCC
4 [ Executable
& Empty Project
& Hello World AMSI C Project
- [ Shared Library
- [2= Static Library
4 = Others
<» FT90x D23X Project
<» FT90x Diata Logger Project
- = Makefile project

Figure 50 FTDI Project Types

32
Product Page
Document Feedback Copyright © Future Technology Devices International Limited


http://www.ftdichip.com/FTProducts.htm
mailto:docufeedback@ftdichip.com?subject=Document%20Feedback:%20AN_325%20Version%201.03
http://www.ftdichip.com/Support/Documents/AppNotes/AN_360%20FT900%20Example%20Applications.pdf

'-'-..\‘
/ \

'/

=N\

FTDI
Chip

Application Note

AN_325 FT90x Toolchain Installation Guide
Version 1.03

Document Reference No.: FT_001041 Clearance No.: FTDI# 452

The procedure to create a new project is similar to the empty project. When the wizard completes,
a template source file will be generated. Below is the template generated for the D2XX project.

& m

R e e e
INENR TR TR TR TR

[ TR
DOm UGNk WR R ® 02

141

ainc  [g mainc i
loop();

Event handling */

if (D2XXTEST__ DfuDetach)

¥
i
t

delayms(18@);

/* DFU detach request had come. Exit D2XX */

D2XX_Exit();

/* Take the system to DFU Mode. Provide timeout in mg to
wait for re-enumeration with the host

STARTUP_DFU(@);
break;

Suspend mode handling

(DZXXTEST__Suspend)

wkupScurce = @3

_

dbg("Entering Suspend Mode at Master \rin");

delayms(1e@);

#ifdef GPIO_REMOTE_WAKEUP
SetRemotelakeup = @;
if (RemoteliakeupEnable)

#endif

dbg("Configuring GPIO pin to wakeup \rin");
#if 1

/* Set up the pin */
gpio_dir(GPIO_PIN, pad_dir_input);
gpio_pull(GPIO_PIN, pad pull pullup);

/* Attach an interrupt */
gpio_interrupt_enable(GPIO_PIN, gpio int_edge falling);

int

upt_attach(interrupt_gpie, (uints_t)interrupt_gpio, ISR_gpio);

dbg("D2XXTEST: GPIO pin setup for interruptirin”});

#endif

<

.

Figure 51 D2XX Project Template

=

|

-

[

The template can be compiled as it is but additional code is needed to customize it according to

the user’s need.

[£] main.c

Gk WR P ® W -

[

e e e e e
|FYIREYIRL IR FTIR YIRSV YIRS FYIR VIR AV O O

o

o

o
EERRE
pri it

145
146
147
143
149
158
151
152
153
154
155
156

158
159
168
16l
162
163
164
165
166
167

#endif

loop();

File Edit Source Refactor
|8 R B E R GG OB R EE T o
Quick Access - :53 |’§.‘\.t Debug

g main.c 2 =0 Fon ™ = g

[ Project Explorer 532

=
» 5 Hello World
a 5 TestD2xx
. # Binaries
> [ Includes
> (= Debug
(= Includes
: (= Scripts
4 = Sources
> 8 ert0s

. |[@ main.c

=3

o

Navigate Search Project Run FTDIUtilities Window Help

~

loop(); FEER e

o o

/* Event handling */ stdint.h
if (D2XXTEST_ Dfubetach)
{

4| mo |

B e
IR VR e

=)

string.h
rhmeh

1#] Problems =| Tasks [ Console 32 | [C] Properties

COT Build Console [TestD2XX]

'Building target: TestD2XX.elf'

'Inveoking: FT98x GCC Linker'

ft32-elf-gcc -nostartfiles -L"C:/Program Files/FTDI/FT98x Toolchain/Toolchain/hardware/.
'Finished building target: TestD2XX.elf'

'Inveoking: FT98x Flash File Generator'

ft32-elf-objcopy --output-target binary "TestD2XX.elf" "TestD2XX.bin"
'Finished building: TestD2XX.bin'

'Invoking: FT98x Display Image Size'|

ft32-elf-size --format=berkeley -x "TestD2XX.elf"
text data bss dec hex filename

@a3ebee Bx434 @x2284 266334 41284 TestD2XX.elf

'Finished building: SIZE'

< | 1

4|

1

Figure 52 Compiling D2XX Template Code
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6 Advanced Topics

6.1 Running the toolchain from the command prompt

6.1.1 Compiling the sample applications using a Makefile

The FT90x GNU toolchain can be used to compile source code from a command prompt in the
same way the official GNU Toolchain is used, often with the help of a Makefile or a batch file.

The sample applications are available in "My Documents\FTDI\FT90x\Examples\ if you have
installed them using the installation wizard.

NOTE: makefiles are not included with the toolchain installer.

6.1.2 Programming a binary file into the chip

The programmer can be found in the folder “programmer\dist” in the program installation directory
(C:\Program Files (x86)\FTDI\FT90x Toolchain). The command line programmer is FT900Prog.exe.
The toolchain is provided with a default bootloader. The bootloader is located at the top 4 KB of
the flash memory (address O0x3F000 to Ox3FFFF). At boot, the FT90x resets and executes
instruction at 0x00000, jumping into the bootloader. The bootloader then performs the
initializations needed and jumps to location 0x8c, which is the start of the user program. The
bootloader is also needed to support debugging with the FT90x port of GDB.

1. Run the tool FT900Prog.exe without any arguments, the options and usage will be printed.
They will also be printed if the specified options are not valid. The most common usage is
programming a binary file through the one-wire interface with the supplied bootloader. To do
this, the command is:

FT900Prog.exe -f <.bin file with path if needed> -O
in which the options are:

-f: programming the binary file into the flash. The path to the binary file must follow.
-0: using the one-wire interface.

If you want to verify the content of the flash memory after programming, specify “-v” in the
command:

FT900Prog.exe -f <.bin file with path if needed> -0 -v

2. If the bootloader is not required, option “-x” can be specified, in which case the program will
start executing from address zero and the command is:

FT900Prog.exe -f <.bin file with path if needed> -0 -x

The supports for GDB debugging will not be available however.
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6.1.3 Debugging the sample applications with ft32-elf-gdb

1. The applications must to be compiled with -g option (i.e. ft32-elf-gcc -g ...). An .elf file will be
created which includes the debug information, for example GPIO/gpio_examplel.elf. Note that
this file is not used for programming the chip.

Note: If the output file name for the linker is not specified in the Makefile (i.e. option -o is
missing), a.out will be created instead of an .elf file. They are the same and these steps can be
applied to a.out as well.

2. Flash the .bin file into the chip. Refer to section 5.1.2 above.

3. Open a command line window, run:
“python <Installation directory>\Toolchain\utilities\gdb_bridge.py live”

Note: An alternative is to double click on the shortcut "GDB Bridge” created after the
installation.

The correct response should be:

-

= = ———— ——— —— ——— — —~ ul
B8 C\Windows\System32\cmd.exe - gdb_bridge.py live o o - ) - [E=NEE

Microsoft Windows [Uewrsion 6.1.76811
Copyright (c> 2087 Microsoft Corporation. A1l rights reserved.

C=“Program Files (xB6>X~FTDI~FI98x Toolchain“Toolchain~utilities>gdh_bridge.py live
D2X¥ library loaded OK

— il 'ﬂ

Figure 53 FT90x Debugging Status

Note 1: If there is an error message about permission being denied, the command line
window may need to be opened with administrator rights by right-clicking and selecting 'Run
as administrator”’.

Note 2: [t is also possible to run the GDB Bridge using the shortcut created after the
installation.

Note 3: If the path to gdb_bridge.py contains spaces, enclose it with double quotes ("”).

4. Open another command line window, go to the folder that includes the .elf file, run “ft32-elf-
gdb <.elf file>", for example “ft32-elf-gdb gpio_examplel.elf”.

5. After ft32-elf-gdb starts, type in “target remote localhost:9998” to establish a connection to

the MCU.

6. Use standard GDB commands to debug the program. Note that the command to start
execution should be “continue”, not “run”.
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6.2 Installing Eclipse and the FT90x plugin manually

When running the installer, it is possible to choose not to install Eclipse as part of the installation.
This might be useful if the user have already installed Eclipse for other purposes. This section
details how to set it up for use with the FT90x.

6.2.1 Eclipse Install

1. Go to Eclipse website, download “Eclipse IDE for C/C++ Developers”. At the time of this
writing, Eclipse Mars is the latest release and is the recommended version.

2l Windows
& 166 MB 1,144,540 DOWNLOADS
€ . 3 \
The essential tools for any Java developer, including a Java IDE, & Git client,
XML Editor, Mylyn, Maven integration and WindowBuilder...
w Windows
(o
T 176 MB 449,358 DOWNLOADS 3
L5 = \
An IDE for C/C+ developers with Mylyn integration.
A Windows
— 244 MB 297,100 DOWNLOADS 3
- =) \
Package suited for development of Eclipse itself at Eclipse.
Windows
— 153 MB 281,587 DOWNLOADS
@ & \
The essential tools for any PHP developer, including PHP language suppart,
Git client, Mylyn and editors for JavaScript, HTML, CS5 and...
Windows
é 296 MB  170.55% DOWNLOADS
-7 & |

The essential tools for Java and DSL developers, including a Java & Xtend
DE, a DSL Framewark (Xtext), a Git client.

Figure 54 Eclipse Versions

2. When Eclipse is run for the first time, it will ask for the workspace location.

= Workspace Launcher @

Select a workspace

Eclipse stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session,

Workspace: hd Browse...

["] Use this as the default and do not ask again

Figure 55 Eclipse Workspace Location
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A workspace is a directory on the hard drive where Eclipse stores the projects defined to it.
More specifically, a workspace is a logical collection of projects. When you specify this
directory name to Eclipse, Eclipse will create some files within this directory to manage the
projects. The projects controlled by this workspace may or may not reside in this directory.
Specify a directory name and click OK.

Note: To run Eclipse, it is required to download and install the Java Run Time Environment
(JRE) or Java Developer Kit (JDK). Eclipse should display a warning if this is not installed.
Oracle provides these tools for free.

6.2.2 FT900 Eclipse Plugin Installation

To assist with completing the configuration of Eclipse for FT900 coding an extra plug-in is provided
as part of the download. To install the plug-in the following steps are required:

1. From the Eclipse toolbar select Help -> Install New Software which will pop up the window as

below.
& Install o — - Fro— R X
Available Software
Check the items that you wish to install. )-__

Work with:  file:/ | N 1 - - chain/eclipse plugins/com.ftdichip.f90x/ - Add...

Find more software by working with the "Available Software Sites” preferences.

type filter text

MName Version

4 (00 FTDIchip FT90x Eclipse Plugins

L+ FTDIchip FT90x Resources 0.0.1.201505270753
4 T b
Select All | [ Deselect Al

Details
/| Show only the latest versions of available software /| Hide items that are already installed
/| Group items by category What is already installed?

Show only software applicable te target environment

/| Contact all update sites during install to find required software

m

< Bad lext > Finish Cancel

Figure 56 Eclipse Plugin Setup Wizard

2. Select the ADD button, and browse to the LOCAL location of the folder ‘com.ftdichip.fto0x’
which can be found in “Toolchain\eclipse plugins” in the toolchain installation directory.

3. Press “SELECT ALL” followed by NEXT to install the plugin

4. Close the window when complete.
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6.3 Common project settings in Eclipse

6.3.1 Include paths

Eclipse uses its built-in indexer to resolve dependencies between files. In order for the indexer to
work correctly, paths that contain the header files in the project need to be added as follows:

1. Right-click on the project and select Properties

= C/C++ - FT90x_Examples/GPIO/gpio_exampleLls - Eclipse (5 e S
File Edit Source Refactor MNavigate Search Project Run Window Help
- @&~ @miN & eI T @i T O R A T ) G
Quick Access 5 | [EEc/Ces ) 35 Debug
[ Project Explorer £3 =0 (€] gpio_examplel.c 52 =0 4 Search 52 ‘= =0 |
8% = 38 = opportunity; loss of goodwill or reputation; and/or loss of, damage to or - ) = IR
T T e—— 39 * corruption of data =
4 i FT90 Exi y. N search results available. Start a o]
> Bl Includ New b been amended by another user and then search from the search dislog. =
» = ADC Go Into dapted Software®). If so that user may
& Came t apply to those amendments. However, FTDI
= CAN QOpen in New Window those amendments.
> & PAC = copy CtrlsC
@ Bthey = o
» (= GPIO e e L
» @»CM X Delete Delete F
» @ 2CS| & Removefrom Contert Ctrl+Alt+Shift+ Down
> B 125 Source »
& lib Move...
s G PWM
. = RTC Rename... F2
T g tmport,
B 0w ) 4 Export
1
S uidproject
o 19000
o sy CleanProject I
# GPog & Refresh [
# STRO Close Project
# STRO Close Unrelated Projects. I Console 1
#+ loopive
o loon0 @ s » fation] C:\FT800\toelchain\programmendist\FT900Prog.exe (26/1/15 5:56 pm)
© main(y  Make Targets D =
£osetupl e » g utility!ll
® setupl e
Show in Remote Systems view
Profiling Teols >
Convert To.
fra
3
Profile As i i
Debug As »
. Run As »
=5 FT90x Example
= 7" Compare With »
Restore from Local History...
4 Run C/C++ Code Analysis
Team »
| Properies Alt-Enter |

2. In the Properties window, select C/C++ General > Paths and Symbols

Figure 57 Eclipse Project Properties
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P

= Properties for hellowarld l (S0 | S
type filter text Paths and Symbols - v
» Resource
Builders
. C/Cs+ Build Configuration: [Default [ Active ] v] [Manage Conﬁgurahons...l
a C/C++ General
: Code Analysis
Dacumentation (5 Includes | # Symbols | = Libranasl B Library Pathsl [ Source Location | (=% Qutput Location | i [
File Types
Formatter Languages Include directories Add...
Indexer Assembly i
Language Mappings GNU C 0
Paths and Symbols GNU C++ Delete
Preprocessor Include Pz
Profiling Categories Export
Project References
Run/Debug Settings.
y Move Up
> Task Repository
WikiText Move Down
(D) "PreprocessorInclude Paths, Macros etc.” property page may define additional entries
Show built-in values
[ £ Import Settings... ] [ S Export Settings...
. - . Restore Defaulis| [ apply |
=
@ [ ok ][ coenca |

Figure 58 Eclipse Paths and Symbols

3. Under the Includes tab, choose "GNU C” under Languages, then click “Add...” on the right
side of the window

4. In the “Add directory path” window, specify the path to the folder that contains the header
files. If the same path is used for some C++ files, check the box “Add to all languages”,
then click OK.

8 " Add directory path @

Directory:

[] Add to all configurations

[] Add to all languages
[[] = Is a workspace path

Figure 59 Eclipse Add Directory Path

Note: The paths should be added one at a time. The use of semicolon is not supported.

6.3.2 Toolchain settings

The FT90x toolchain supports most GNU toolchain options. To specify an option that is not included
by default, for example to create a map file, do it as follows:
1. Right click on the project and select Properties

2. In the Properties window, select C/C++ Build > Settings. The toolchain settings can be
adjusted in the Settings window.
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= Properties for Hello World o e

type filter text Settings =
> Resource
Builders
4 C/Cre Build Configuration; Debug [ Active] ~ | [Manzge Configurations...

Build Variables
Environment

Logging 1 Tool Settings | # Build Steps Build Artifact | [} Binary Parsers | @ Error Parsers|
Settings
Teol Chain Editar (5 FT90x Toolchain Settings Command:  gec
» C/Ce General + [BuBIsCCECompiley Alloptions: -0 -g -Wall -c -fmessage-length=0 -ffunction- =
Project References (2 Dialect sections
Run/Debug Settings % Preprocessor

(5 Symbols
(2 Includes
(2% Optimization
@ Debugging Expert settings:
(5 Warnings Command
(8 Miscellaneous line pattern:
4 B FT90x GCC Linker
(2 General
(5 Libraries
(2 Miscellaneous
(2 Shared Library Settings L4
a ) FT90x GCC Assembler
 General
4 B3 FT90x Flash File Generator
(2 General
4 T FT90x Display Image Size
(2 General

m

SICOMMAND} S{FLAGS} S{OUTPUT_FLAG} S{OUTPUT_P

Figure 60 Eclipse Toolchain Settings
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7 Troubleshooting

This section documents the problems you may encounter when using the FT90x toolchain.

7.1 Makefile error

If using a makefile to build an application, some makefile errors may be reported, for example:

E¥ Command Prompt |£|E|ﬂ—hj

Figure 61: Makefile Error

This is usually because some existing toolchain on the system may be using its own “make” utility
which is also referred to in the PATH variable. The FT90x examples need to be built by the
GnuWin32 “make” utility, which can be installed during the toolchain installation. To solve this
problem, adjust the PATH variable so that the correct "make” utility is called by the toolchain. Note
that it may be necessary to adjust PATH again for the other toolchain. Type “where make” in a
command prompt to find out which “make” utilities are present on the system.

E® Command Prompt |ﬂlﬁ

am Fil
18611¢

Figure 62 "make" Locations
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Document References
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TN_160 Eclipse Projects

Acronyms and Abbreviations

Terms Description
CMD Command-line interface
DLL Dynamic-link Library
DLOG Data Log (Project)
GAS GNU Assembler
GCC GNU Compiler Collection
GDB GNU Project Debugger
GNU GNU (Gnu's Not Unix) Operating System
GUI Graphical User Interface
IDE Integrated Development Environment
JDK Java Development Kit
JRE Java Runtime Environment
MCU Microcontroller Unit
PATH PATH Environment Variable
TCP Transmission Control Protocol
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